
 

CleverClients 

Release 3.1 

August 2019 
 

The Clever Company Pty Ltd 

https://sourceforge.net/projects/cleverclients/ 

https://sourceforge.net/projects/cleverclients/


 ii 

TABLE OF CONTENTS 

TABLE OF CONTENTS ....................................................................................................... II 

QUICK START ........................................................................................................................ 1 

1. INTRODUCTION................................................................................................................ 2 

1.0 BACKGROUND ........................................................................................................ 2 

1.1 THIS MANUAL .............................................................................................. 2 

2.0 GETTING STARTED ............................................................................................ 3 

2.1 INSTALLATION ............................................................................................ 3 

2.2 FILES ............................................................................................................... 3 

2.3 JAVA ................................................................................................................ 4 

2.4 RUNNING THE DEMONSTRATION BUSINESSES ............................... 5 

2.5 CONFIGURING WINDOWS ....................................................................... 5 

2.6 AUTOMATIC START ................................................................................... 6 

3.0 THE BASICS ........................................................................................................... 8 

3.1 INTRODUCTION .......................................................................................... 8 

3.2 TOOL TIPS ................................................................................................... 10 

3.3 BUTTONS ..................................................................................................... 10 

3.4 COLOURS..................................................................................................... 11 

3.5 ERROR MESSAGES ................................................................................... 12 

3.6 SCREEN LAYOUT ...................................................................................... 13 

3.7 NAGGING ..................................................................................................... 13 



 iii 

3.8 CONFIGURATION ..................................................................................... 14 

3.9 COMMAND WINDOW ............................................................................... 14 

3.10 LICENCE ...................................................................................................... 16 

4.0 CLIENTS AND APPOINTMENTS .................................................................... 17 

4.1 INTRODUCTION ........................................................................................ 17 

4.2 CLIENTS ....................................................................................................... 18 

4.3 CLIENT DIRECTORIES ............................................................................ 18 

4.4 APPOINTMENTS ........................................................................................ 19 

5.0 DIARIES ................................................................................................................ 22 

5.1 INTRODUCTION ........................................................................................ 22 

5.2 DIARY DEFINITION .................................................................................. 22 

5.3 USING DIARIES .......................................................................................... 25 

6.0 REFERRERS......................................................................................................... 28 

7.0 ORGANISATIONS AND ASSOCIATES ........................................................... 30 

8.0 FILTERING .......................................................................................................... 32 

9.0 WORD PROCESSOR .......................................................................................... 35 

9.1 INTRODUCTION ........................................................................................ 35 

9.2 EXAMPLE .................................................................................................... 35 

10.0 REPORTS .............................................................................................................. 37 

10.1 INTRODUCTION ........................................................................................ 37 

10.2 EXAMPLE .................................................................................................... 37 

11.0 PLOTS .................................................................................................................... 40 

12.0 MISCELLANEOUS OPTIONS ........................................................................... 42 

12.1 INTRODUCTION ........................................................................................ 42 

12.2 BACKUPS ..................................................................................................... 42 



 iv 

12.3 IMPORTING APPOINTMENTS ............................................................... 44 

13.0 CONFIGURATION .............................................................................................. 47 

13.1 INTRODUCTION ........................................................................................ 47 

13.2 MAIN CONFIGURATION ......................................................................... 48 

13.3 TITLES LIST ................................................................................................ 52 

13.4 RESOURCES ................................................................................................ 53 

13.5 CHECK LIST................................................................................................ 54 

13.6 MARITAL STATUS .................................................................................... 55 

13.7 SERVICE NUMBERS.................................................................................. 56 

13.8 CLIENT TYPES ........................................................................................... 57 

13.9 CONFIGURING WORD PROCESSORS AND SPREADSHEETS ....... 60 

14.0 LETTERS .............................................................................................................. 63 

14.1 EXAMPLE .................................................................................................... 63 

14.2 CONFIGURATION ..................................................................................... 65 

14.3 SUPPLIED LETTERS ................................................................................. 66 

14.4 YOUR LETTERS ......................................................................................... 66 

14.5 RICH TEXT PROBLEMS........................................................................... 68 

15.0 SMS AND MAIL ................................................................................................... 70 

15.1 INTRODUCTION ........................................................................................ 70 

15.2 CONFIGURING MAIL. .............................................................................. 70 

15.3 SMS PROVIDERS........................................................................................ 71 

15.4 REMINDERS ................................................................................................ 72 

15.5 MISSED APPOINTMENTS ........................................................................ 74 

15.6 SENDING SMS ............................................................................................. 74 

15.7 SENDING MAIL .......................................................................................... 75 



 v 

15.8 WORK LISTS ............................................................................................... 75 

15.9 MAIL PROBLEMS ...................................................................................... 76 

16.0 DISASTERS........................................................................................................... 77 

16.1 COMMAND WINDOW ............................................................................... 77 

16.2 NEW COMPUTERS .................................................................................... 77 

16.3 MEMORY ..................................................................................................... 77 

16.4 DATABASE RECOVERY ........................................................................... 78 

16.5 JAVA PROBLEMS ...................................................................................... 80 

DATE FORMATS ................................................................................................................. 81 

16.5.1.1 Date and Time Patterns ............................................................... 81 

16.5.1.2 Examples ....................................................................................... 85 



 1 

QUICK START 

This section is designed to give you a quick look at CleverClients. Everything is described in 

more detail in the following manual. 

You can also look at the extensive information on the web site 

https://sourceforge.net/projects/cleverclients/. 

After you have downloaded and run the setup procedure the system can be started 

using the one of the example businesses. You can try it out immediately, but we 

recommend that you spend a little time to skim through the following chapters. 

You must install Java to use CleverClients. This will normally happen during the 

system setup. 

Java is a standard computer language. It is embedded in your browser, and your 

phone and is used in your on-line banking system. For more information about 

Java go to www.java.com. 
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1. INTRODUCTION 

1.0 Background 

The CleverClients system is developed by the Clever Company; hence the name.  

The software is based on the CleverPsych system for managing single psychologist 

practices. CleverPsych has been in use for several years. 

1.1 This manual 

We are trying to supply a comprehensive manual that will tell you everything you 

need to know when read in association with the web site 

https://sourceforge.net/projects/cleverclients/. 

You should work your way through the manual and look at the supplied 

demonstration businesses.  

You usually start with an example business that is similar to your business, and 

modify the configuration to suit the way you operate. 

When you have done this you will know how to use CleverClients and have a system 

configured for your business. We expect that most users of CleverClients will have a good 

working knowledge of Windows, but we will tend to supply too much detail just in case. This 

extra information will be coloured so you can skip over it if you like. 
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2.0  GETTING STARTED 

2.1 Installation 

CleverClients is supplied as a standard windows setup.exe file. 

The details are on https://sourceforge.net/projects/cleverclients/ 

2.2 Files 

Installation will give you two directories (folders in MS-speak) in the C: drive. 

▪ The software is installed in a standard windows location C:\Program Files 

(x86)\CleverClients. You can remove it using The Windows control panel. 

▪ CleverClientsData holds all the support files for the system including 

databases and configuration files. Initially it contains files for the example 

businesses. All your files will be stored here. The folder is initially in your 

home directory e.g. C:\Users\Fred, and we recommend that you move it later 

to a Cloud service like Dropbox. 
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TopDirs.png – Basic folders 

 

2.3 Java 

The system is written in the Java programming language. Java is extremely widely 

used for applications, in web pages etc. It even runs in mobile phones. 

Before you can use CleverClients you need to install java. This normally happens as 

part of the installation process. 

If CleverClients did not start when you installed it, you should check to see if you 

have java installed by starting a Command Prompt and typing: 

Java -version 

Which will produce something like: 
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If either you do not have java 8 installed or the version is less that 1.8.144 you must 

install Java. This is usually done by the setup script. You can download the latest version of 

the Java runtime System (JRE)  from the Java site www.java.com. 

If you buy a new computer you may have to download the latest version of Java. 

2.4 Running the demonstration businesses 

When you install CleverClients it starts in evaluation mode, and you can look at some 

example businesses. The differences are the way CleverClients has been configured 

You can swap between the businesses by selecting from the Evaluation menu. 

2.5 Configuring Windows 

CleverClients continually runs background tasks to: 

• Send reminders. 

• Clean up the disk 

• Backup the database 

• Send daily appointment lists 

• Etc 

For this reason you usually need to have your computer running all the time.  

http://www.java.com/
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If you have a laptop you should consider plugging it in at home overnight or when in 

your office and configuring the system for when the background processes are run. 

You need to go into the Control Panel, select Power Options, and make sure that 

powering off is set to “Never”. Restart your computer afterwards. 

 

 

2.6 Automatic Start 

We find that Microsoft updates our computer on Saturday nights, and the computer restarts. 

 

This means that CleverClients is not running, so the reminders for Monday are not sent. 

 

You may have noticed that you have a folder called "Startup" in your Programs menu. 
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Anything you put into this folder, Windows will launch on startup—so setting an app to 

automatically launch is easy: 

 First, select the CleverClients icon. Right-click on it and hit "Copy". This will copy the 

shortcut. 

 Find the Startup folder in All Programs and right click on it. Hit "Open", and it'll open up in 

Windows Explorer. 

 Right click anywhere inside that window and hit "Paste". Your desired program's shortcut 

should pop right up in the folder, and the next time your computer starts, that program will 

automatically start up. 
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3.0  THE BASICS 

3.1 Introduction 

When you start the system (by clicking the Demo icon) the main screen appears. You 

will find that you need to zoom in and out via the “+” and “-“  buttons on your PDF viewer to 

see the detail of some of the pictures in this manual. 

 

MainScreen.png 



 9 

The left side of the screen shows your clients and their appointments (with the latest on the 

top) as a “tree”. You can expand and contract the tree and select clients and appointments in a 

similar way as how you use Windows Explorer. 

The definition of the selected client appears in the right pane with any selected 

appointment below it. 

Definition of clients, appointments etc is done by typing into the appropriate fields 

and clicking a button to insert into or change values in the database 

This is the main screen for the psychologists example business which uses most of the 

CleverClients facilities. In practice, you may want to “turn off” some of the capabilities to 

simplify the interface e.g. here is an example business for an electrician who makes 

appointments to visit his clients to carry out electrical work. 

 

MainScreen2.png 

So try defining a new client, using the buttons below the client pane:  

Click the Clear button to initialise the fields. 

Type the given name and surname. 

Select a title (Mr, Mrs etc) 
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Select a client type e.g. Private. 

Click the Add button under the client pane to store the client in the database. The 

client will appear at the bottom of the tree and a message will appear at the bottom of the 

window. 

 

Next give the client an appointment: 

Select an appointment time. 

Most fields will have been filled out according to the client type. 

Click the Add button below the appointment pane. 

The appointment will appear in the tree and a message will appear at the bottom of the 

window. 

 

Next try modifying the client. Perhaps enter an Email address.  

Click the Modify button below the client pane to store the changes into the database. 

A message will appear at the bottom of the screen. 

3.2 Tool Tips 

If you “hover” the mouse cursor over a button, field or menu item some text will pop up that 

will provide some brief information. 

3.3 Buttons 
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Storing of information into the database is controlled by sets of buttons below the 

relevant fields on the screen (by a field we mean where data such as a name is displayed and 

entered). 

 

Generally the process is: 

▪ To enter new data (such as an appointment) click the Clear button  to blank 

the fields or set them to default values. You can then type values into the 

fields. 

▪ To actually store some new information (such as a new client) into the 

database you click the relevant Add button. 

▪ To modify a displayed definition type the new values into the fields and then 

click Modify to set the new values in the database. 

▪ To delete the currently displayed definition from the database click the Delete 

button. Hence you could delete a simple definition such as an appointment, but 

if you delete a client all of its appointments will also be removed. In practice 

you will seldom delete anything. 

The important point is that there are no changes to the data stored in the database 

unless you click a button. This means that if you change your mind after typing in something 

the original is still stored. There is no “undo” function (unless you restore the database from a 

backup). Be careful to click from the correct set of buttons. 

3.4 Colours 

The system use the “traffic lights” colouring system. i.e. 

Red(ish) is bad 
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Green(ish) is good (as usually is black) 

Orange(ish) is somewhere in between 

For example, if you type clear to input a new client the two name fields that must be 

entered are coloured red and other fields that you should enter (but can leave for now) appear 

yellow. 

Similarly the appointments in the tree should be green. If not some data has to be 

modified. Client names are also coloured in the tree. 

The text used in the tree for clients, appointments and services is colored according to 

status. The colours used can be listed from the Help menu. 

 

The icons are coloured in the tree to indicate when there is a problem (you can display 

a validation report, probably for all clients and their appointments to find what is wrong). 

3.5 Error Messages 
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Messages appear at the bottom of the window when you initiate a process e.g. click a 

Add button.  

Messages are coloured as above i.e. green if successful, yellow if successful but you 

should do something, and red if the operation failed and you need to fix the problem. 

3.6 Screen Layout 

The screen has been designed to run on our old low resolution monitors. 

You can use the usual operations of making the window full screen if you too cant 

afford the latest, or can expand it to a larger size. 

You can also “drag” the bars to make the tree wider or to change the size of the 

appointment area. 

So far we have only discussed clients and their appointments, but you can click on the 

“tabs” to show other information. 

Hopefully this is all standard information as far as you are concerned. 

3.7 Nagging 

The philosophy of the system is that you are seldom forced to do anything, but if you 

should, something (usually a field and the tree) will be coloured yellow. If you must do 

something it is coloured red. 

For example, you will often enter a new client and a first appointment without 

knowing much about them so fields like date of birth could be yellow. 

For example you don’t have to input the fee for an appointment, but if you don’t the 

fee field will be yellow, and after saving into the database the appointment icon in the tree 
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will also be coloured. However, should you display a report of your income it will not be 

accurate. 

The aim is to have everything in the tree coloured green! 

3.8 Configuration 

The system can be configured for your type of clients and the way that you work. This 

will be covered later, but briefly, the system is controlled by “configuration files”. 

For example a client’s title (Mr, Mrs etc) is chosen from the pulldown in the Client 

definition pane which is loaded from a configuration file. You can change the list by editing 

the file. 

For example if Captain Kidd walks through you door you can add “Captain” to the 

configuration file (and hence to the pulldown list). Then you can use his title when adding 

him as a client. 

 

 

3.9 Command Window 

When you start the system a command prompt window also appears. 
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This window shows the commands that are run to start up CleverClients. More 

importantly it will display error messages if there is something wrong with your system. 

You can change the properties on the icon (right click) so the window is minimized. 

The default window does not show many lines. You can click on the top left icon to 

show the properties and then increase the default maximum lines (e.g. to 5000 as below). You 

may want to change the font size too. 

You can use the Edit menu to select all and copy. Then you can paste the contents into 

an Email if you need to advise of a problem. 
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3.10 Licence 

The software is now free. No licence is required.. 
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4.0  CLIENTS AND 

APPOINTMENTS 

4.1 Introduction 

The first you hear of a new client is usually when they ring for an appointment for 

you to provide a service. For example if a new client Santa Claus rings and says he wants 

your company to service his car, you can click the client Clear button and type in the minimal 

information for the client and click Add, and then enter an initial appointment in a similar 

way. 
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The first thing you will notice is that some fields are yellow signifying that you 

should enter some value. Which fields are required are specified when the client type is 

defined. Most government and insurance types will require a reference number. There is 

much more said about this later. 

4.2 Clients 

Hopefully most client fields are obvious, but some other details are: 

▪ The given name and surname fields must be given as together they uniquely 

identify the client. We usually use just one given name. If by chance you have 

two clients with the same name you have to differentiate between them e.g. 

give an initial or second name. 

▪ The mobile phone numbers are used for sending reminders, so input them if 

you can. Usually there is just one mobile number, but you can provide more, 

separated by commas, if the reminder should go to more than one person. 

▪ The Email is used for reminders if there is no mobile number. 

▪ The memo field can be used for a quick reminder.  If the action reqd flag is 

ticked the client will be coloured in the tree. 

▪ A check list can be set up to remind you of the procedure you have done. We 

would often send an acknowledgement letter to the doctor, give a PAI at the 

first appointment, send a mid-session letter requesting further treatment, and 

have some final administration after the final session. 

4.3 Client Directories 



 19 

When you create a client a directory is set up for them under the clients directory. 

 

To allow for the large number of clients in your business, the directories are actually 

stored under another level of directories that is the first letter of the surname (if you change a 

client’s name you will have to manually move the directory). 

You can use these directories to store any client files. CleverClients stores client files 

such as letters there. 

 

4.4 Appointments 

Appointments are identified by their time. 

As with clients, there are some subtleties about the appointment fields. 

The appointment status has fixed values and has to be reset after the appointment: 

▪ New client – indicates a first appointment. 

▪ Scheduled – a new appointment. 

▪ Paid cash – a cash client attended and paid. Used for income that does not 

appear on your bank statements. 

▪ Paid cheque – a cash client attended and paid with a cheque. 
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▪ Paid card – a cash client attended and paid with a credit card. 

▪ Paid other – a cash client attended and paid by some other means. 

▪ Owed– a cash client attended but did not pay. The tree icon is red. 

▪ No show – did not turn up. This is a major problem. See reminders later. 

▪ Cancelled – phoned to say they could not come. You usually do this rather 

than delete the appointment as it indicates unreliable clients. 

▪ Claimed – you have submitted a claim for payment to the government or 

insurance company. The system will indicate when you have been slack and 

have not claimed within a reasonable time. 

▪ Attended – the client came to the appointment (you may need to claim) 

▪ Invoiced – you have sent an invoice. 

▪ Rejected – your claim or invoice was rejected and you need to send a revised 

one. 

Details of other appointment fields are: 

▪ Fee and tax are loaded with values defined in the configuration, but you can 

change them. Tax to us is the Goods and Services Tax (GST) which applies to 

some services. We record GST as 10% on top of the basic fee, but you can 

handle tax any way you like (consistently!) e.g. included in the fee. 

▪ Client type is set to that of the client. However the type can change e.g. 

someone may first attend as a private patient and the go to a doctor and enter a 

government scheme. This field enables old appointments to display their type 

at the time. 

▪ Service number is a configured list of government or insurance service 

identifiers. 

▪ Reminded tells if a reminder has been sent to the client. 
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▪ In external database can be used when you have to enter appointment details 

in a government database. 

▪ Group appointment can be set to enable more that one client to attend at the 

same time. Normally the system will only allow one appointment at a time. 

 

You can generate a sequence of appointments by creating a new appointment that is 

the first in the sequence (get it right!) and then clicking the Recurring button to display the 

dialog: 
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5.0  DIARIES 

5.1 Introduction 

A diary typically shows the appointments for one member of staff, and there must be at least 

one diary. 

A sole operator business will probably have just one diary that shows the appointments made 

(for times the owner will visit clients or when they will come to the office). 

There are many reasons why there would be more than one diary, and some are: 

• A sole operator may work at more than one office on different days of the 

week and have a diary for each location. 

• A business may have several staff, each of whom has a diary. 

• A business may operate an answering service for tradesmen, and have a diary 

for each of them to schedule their work. 

• A business may have teams of workers and have a diary for each team (and 

can move workers between teams as required). 

5.2 Diary Definition 

Diaries are defined using the diary tab. 

The main field is the identifier. This is the name that appears on the tab at the 

top and against the appointment. When the Clear button is clicked in the 
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appointment tab, the currently selected diary is what appears (and it can be 

changed). 

Each diary has a main person defined. This is often a single worker, but as a 

diary can reference a group of staff / workers it should be the foreman or main 

contact. 

Daily work lists can be sent to the works in a diary so a cell phone (for SMS) 

and Email addresses should be given. Where there are several workers the 

phone numbers and emails should be separated by commas e.g. “06 123 456 

789, 06 987 654 321” 

The tick box at the bottom must be set to indicate if the workers usually go to 

the client’s premises or if the client will attend at the business office (clinic 

etc). 

You cannot delete a diary, as it is probably referenced by appointments if your 

database; instead set it to disabled. 

For example, here is a diary for sole trader or single employee who is a 

mechanic, so clients bring their cars to his workshop. 
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DiarySingle.png 

Another example is for a team of cleaners who go to clients houses. Every 

worker has a phone number recorded for SMS and an Email so they can be 

sent daily lists of clients to visit. 

 

DiaryTeams.png 

The appearance of the diary is defined in the main configuration file. See later: 

# Diary definition. Range 1 to 23. Interval must be 10,15,20,30 or 60  
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Diary min hour=7 

Diary max hour=20 

Diary interval minutes=30 

5.3 Using Diaries 

Often small businesses are run with a diary and a phone. 

Clients ring to make appointments, often at odd hours, and the new appointment is 

written into the diary.   At a convenient time the appointment (and new client information) 

are entered into CleverClients. 

Hence the diary is often the ultimate record of activities within the business. 

There may also be a secretary who enters everything into CleverClients. 

CleverClients provides a diary view of appointments and services. You can use it the 

select appointments and to set appointment times, but the ultimate use is as a check that you 

have entered data correctly. 

Hence the CleverClients diary should look the same as your paper one. 

DiaryCrazy.png 

You select the named diary tab to see the current diary page. 
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Diary entries change as you define and modify appointments and services: 

▪ Appointments are shown as the client name. 

▪ Services are displayed as the type e.g. Forensic report or as  

▪ Group appointments are shown as “Group”.   

▪ Cancelled appointments are shown as “Cancelled”. You can assign these times 

to someone else. 

Problem entries are coloured. 

 

When you select an appointment or service in the tree the relevant diary page will be 

shown. You can skip weeks backwards or forwards by clicking the arrow buttons. You can 

also input a date and click the Page button to skip to the page containing that date. 

If you click on a “Group” appointment entry a list of the clients will pop up and you 

can select a client’s appointment. 

 

 

 

You can reserve a period of time by clicking the Reserve button to display the dialog: 
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 ReserveDialog.png 

You give the time range and reason. 

The diary will be coloured and the reason displayed. 

Reserved slots act as a background and appointments and services within the range 

will still appear. 

You can remove a reservation by clicking in the range and using the Unreserve 

button. 
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6.0  REFERRERS 

People who refer clients to you are defined in the “Referer” tab and are defined in a similar 

way to clients and appointments. 

You use the Clear and Add buttons to enter a referrer and the Modify button to put 

any changes into the database in the usual way. 

 

 

referrer.png 

After referrers have been defined they appear in the tree, and also in the pulldown on 

the client pane so they can be referenced by clients. 
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To modify the definition of a referrer choose from the pulldown in the client pane. 

When a client is chosen any referrer is displayed in the referrer pane. 

We expect that you will only have a small number of referrers. 

You should not delete a referrer if it is referenced by a client. 

 

Referrers are identified by their name and reference / provider number. You can have 

more than one entry for a doctor who works at several medical practices, and has a different 

provider number for each practice. Similarly for people who refer to your business. 
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7.0  ORGANISATIONS AND 

ASSOCIATES 

Organisations that ask you to provide services or to see clients are defined in the 

“Organisations” tab and are defined in a similar way to referrers. 

Associates are people who you do business with (other psychologists, psychiatrists, 

parole officers etc). 

You use the Clear and Add buttons to enter an organisation and the Modify button to 

put any changes into the database in the usual way. 

 

 

After organisations  have been defined they appear in the tree and in the pulldown on 

the client pane so they can be referenced by clients. 
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To modify the definition of an organisation choose from the pulldown in the client 

pane. 

When a client is chosen any referenced organisation is displayed in the referrer pane. 

We expect that you will only have a small number of organisations. 

You should not delete an organisation if it is referenced by a client. 

Associates are handled in a similar way to organisations and referrers. 
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8.0  FILTERING 

The tree usually displays a subset of your appointments and provided services; typically just 

the past month (the demo system is a special case and displays so all the example data 

appears). 

This has the effect of making the tree much smaller and makes it easier to select 

appointments and clients. 

A major reason for filtering is that it defines the data to be processed e.g. you may 

wish to display your income when you are doing your Tax return. In that case you set the 

time range to the financial year, filter, and then display the report. 

You can specify the appointments to be displayed and processed by setting values in 

the Filter tab. 

 

Filter.png 



 33 

The various fields are used as follows: 

▪ Date range – retrieves appointments and services with dates within the range. 

Also retrieves clients who have their current referral date within the range. 

▪ Client type – displays a dialog from which types can be selected. 

▪ Appointment Status – displays a dialog from which status can be selected. 

▪ Service Status – displays a dialog from which status can be selected. 

▪ Client – retrieves clients who have the typed string in their name (case 

insensitive) 

▪ Referrer – retrieves referrers who have the typed string in their name (case 

insensitive) 

▪ Organisation – retrieves organisations that have the typed string in their name 

(case insensitive) 

▪ All – is a quick way of showing everything in the database. This also retrieves 

clients who have no appointments. 

Clicking some buttons display a dialog from which several types or status can be 

selected. The selection remains until changed. 
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Be aware that the client icons in the tree are coloured according to whether the client 

and all appointments are valid. This means that the client can be coloured red, but the 

displayed client fields are all valid and the displayed appointments and services are 

green. This means that some appointment or service that has been filtered out has a 

problem. 
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9.0  WORD PROCESSOR 

9.1 Introduction 

You can generate letters in your word processor by selecting the relevant appointment 

or service in the tree and then selecting a type of letter from the Word menu. 

The letters are actually generated using template files in Microsoft rich text format 

which contain know text strings that are replaces by values from the selected client, 

appointment, service or referrer. You don’t have to use RTF files; any non-binary file type is 

OK. Binary types such as DOCX are not suitable. 

You should be able to use a variety of word processors such as Microsoft Word and 

OpenOffice. 

9.2 Example 

The following letter was generated by selecting Daisy Duck’s first appointment and 

the selecting “Referrer acknowledgement” from the Office menu. 
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We cover in more detail how to generate template files for your own letters and how 

to add the letters to the Office menu later. 

If a letter does not appear in your word processor when you try an example it means 

that CleverClients cannot find your word processor. The system will try and use wordpad 

(from Start->All Programs->accessories)  as a last resort. See the configuration chapter. 
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10.0  REPORTS 

10.1 Introduction 

The CleverClients system can generate several reports. The process is: 

▪ Filter to get the data that you wish to report on. 

▪ Select a report from the report men 

▪ The report will be displayed in the Report tabbed pane. 

▪ Select the “Word” item from the Report menu if you wish to load it into your 

word processor (and hence into another report). 

10.2 Example 

If you select the Clients report you will see something like the following: 
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If you then load the report into the word processor (using the Reports->Word menu 

item) you will see: 
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Every report is written to a file Report.rtl in the tmp directory, and selecting the Word 

menu item simply reads that file into the word processor. You will probably find that only 

one report can be loaded into the word processor at a time. 



 40 

11.0  PLOTS 

Plots and histograms can be produced in much the same way as reports i.e. filter to 

display the appointments and services you are interested in and then select a type of diagram 

from the Plots menu. 

The plots appear in the Plots tabbed pane. 

For example, if you select the “Plot appointments” menu item you will see something 

like the following: 

 

Several types of histograms can be displayed too: 
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12.0  MISCELLANEOUS OPTIONS 

12.1 Introduction 

The “Misc” tabbed pane contains the “odds and ends”. Currently this is reminders to do 

backups and parameters for importing basic data. 

 

 

Misc.png 

12.2 Backups 
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While we know that you diligently back up your data, we suspect that not everyone 

does so. 

You enter the date into the Misc pane when you do a backup, and the system will 

remind you to do another one after a few days. The number of days is a configuration item 

and is usually set to 7. 

 

 

We suggest that you back up your system at least once a week, so when the disk on 

your computer has a psychotic episode you can reinstall your software and data onto a new 

disk having only lost a few days appointments and clients. 

We backup using CD’s, and the procedure on Windows Xp is: 

▪ Put a new CD into the drive. 

▪ A window pops up, and select “Open writable CD folder using Windows 

Explorer”. This gives you an Explorer window for the CD drive. 

▪ Open another Explorer window, probably for the C: drive. 

▪ Drag the folders you want to back up into the CD driver window. You need 

your data directory e.g. CleverClientsData and probably the CleverClients 

folder. Backup anything else of value too. 

▪ You will have to wait for files to be copied. 

▪ When all folders are in the CD Drive Explorer window select “Write these 

files to CD” and the CD Writing wizard appears which controls the actual 

writing. 
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We suggest that you sometimes check that the data are actually on the CD. There have 

been many cases where, after some disaster, it has been found that the data could not be 

recovered from the backup. 

You should keep your backup CD’s somewhere away from your computer so that 

when your office burns down you still have your data. If you use a laptop and take it home 

don’t keep your CDs there. You get the idea. 

These days we suggest you put the CleverClientsData folder on a Cloud service folder 

like Dropbox so you do not have to backup very often. 

12.3 Importing Appointments 

This is currently not available, pending a more extensive implementation. 

There is a very basic facility for importing clients and appointments where you 

already have them on your computer in some form. This is designed to be used when you 

begin to use CleverClients. 

You use the “Comma Separated Values” (CSV) format that is supported by 

spreadsheets. The aim is to set up your data in a spreadsheet in the supported way, export it as 

a CSV file and then import that file into the system. 

If you have your data in a file e.g. a report, you can turn it into a CSV file with say 

NotePad, import it into Excel, manipulate it, and output it as a CSV file for importing.  If the 

report is in word format, export it as a text file. 

Confused? The best way is to start with the demo system: 

Select the File->Export menu item. This will write the file  

CleverDemo\tmp\Export.csv and load it into your spreadsheet. 
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Given Name, Surname, Reference,,,,,,,, 

Daisy,Duck,,7 Jan 2008 12:00 PM,9 Jan 2008 03:30 PM,14 Jan 

2008 12:00 PM,21 Jan 2008 12:00 PM,28 Jan 2008 12:00 PM, 

Donald,Duck,,7 Jan 2008 09:00 AM,9 Jan 2008 03:30 PM,14 Jan 

2008 10:00 AM,21 Jan 2008 10:00 AM,29 Jan 2008 10:00 AM, 

Grumpy,Dwarf,,9 Jan 2008 08:00 AM,16 Jan 2008 08:00 AM,23 Jan 

2008 08:00 AM, 

Snow,White,XX54343646,7 Jan 2008 11:00 AM,14 Jan 2008 11:00 

AM,21 Jan 2008 11:00 AM,28 Jan 2008 11:00 AM, 
 

 

The file gives the spreadsheet column values row by row, where the values are 

separated by columns. There are only a few columns supported, which are in order: 

▪ Given name 

▪ Surname 

▪ Reference number 

▪ Repeated appointment date and times (for each) 

This is extremely simple but does enable existing appointments to be entered. 

To load the data into your database 

▪ Delete the existing database (we assume you are just starting). 

▪ Start CleverClients 

▪ Select File->Import menu item and choose the CSV file. 

▪ The data will appear in the tree. 

▪ You then have to add client data and referrers. 

 

The main problem is that your CSV file could have dates in various formats. You can 

define the formats you want to use in the Misc panel. You can give both import and export 

formats. 



 46 

 If your data has appointment dates but not times, you can set the flag in the Misc 

panel. In this case times will be given as the appointments are entered. 

Date formats are those used by the Java SimpleDateFormat class. Some of the 

documentation is in an Appendix. You can also google to find out more. 

For example CleverClients uses the format “dd MMM yyyy hh:mm a” which prints 

dates and time in the form 25 Dec 2003 10:30 AM. 
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13.0  CONFIGURATION 

13.1 Introduction 

Much of the behaviour of the system is controlled by several configuration files, which are 

held in the CleverClientsData\config folder. 

ConfigDir.png 

You usually change the files by selecting from the Config menu. You can also edit 

them directly with a text editor such as  wordpad (from the Start->Accessories list) or with 

Word.  

When you edit a configuration file, the changes may be applied immediately, but 

often you need to restart CleverClients. 
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You should be careful about deleting items from a configuration file. Make sure that they are 

not being referenced by something in the database. For example, if you added “Sir” to the 

titles configuration file to enter Sir Les Patteson, its not a good idea to remove it later. 

Many config files provide a list that appears, or from which you can select, in the 

panes. You should also order the list as appropriate. 

13.2 Main Configuration 

Most of the system specifications are held in a single configuration file 

Configuration.txt. 

When you first use CleverClients you should edit this file and look at the instructions 

for configuring it for your business. 

Entries are on a single line: 

▪ Lines starting with # are a comment. Rather than deleting lines you should 

consider “commenting them out” as configuration items have a habit of 

coming back. 

▪ Lines have the format NAME=VALUE 

▪ When there are multiple values they are commas separated. This will become 

obvious later. 
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Many of the entries are described later, but some extraneous ones are: 

• Diary definition. Range 1 to 23. Interval must be 10,15,20,30 or 60  

Diary min hour=7 

Diary max hour=20 

Diary interval minutes=30 

▪ Keep backups=31 – The system automatically backs up your database into the 

backup directory. This is the number of days those backups are kept (here a 

month) 
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▪ Keep tmp=7 – The system writes some temporary files into the tmp directory.  

This is the number of days those files are kept (here a week) 

▪ Keep logs=7 – Some logs are generated in the logs directory. This is the 

number of days to keep the logs. 

▪ Backup period=7 – When you backup your system you should enter the date 

into the Misc panel. The system will remind you to do another after this 

number of days. Set to larger value if you use e.g. Dropbox. 

▪ Information about you, for example: 

Business Name = The Funny Farm Ltd 

Business Mail = crazy@gmail.xyz 

Business Phone = 0598765432 

Business Fax = 12344321 

Business Address = 123 Main Street, Hicksville, New York. 

Business contact Full Name = Dr Crazy Horse 

Business reference number = ABN07654321. 

One of the most important feature of the configuration file is to turn off CleverClient 

features that you do not want to use for your business. This particularly impacts the 

appearance of the Client tab. 

 

# =============== Appearance of Clients Pane and associated 

tabs============== 

# 

# Set these true or false to display tabs and related client fields 

# 

# if you want to use referrals 
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Use referrals=true 

# 

# if you want to use associates 

Use associates=true 

# 

# if you want to use organisations 

Use organisations=true 

# 

# Set these true or false to display client fields 

# 

# if you want to use client demographics (DOB, marital status, occupation) 

Use client demographics=true 

# 

# if want to use the client resources used list 

Use client resources=true 

# 

# if want to use the client check list 

Use client check list=true 

# 

# set these values to use the optional client pane fields for your own purposes 

# You change the labels on the fields. SET THEM to NOTHING to hide the field 

# 

# e.g. You are a mechanic and want to store the client's motor vehicle details 

# Optional text 1 label=Vehicle make 

# Optional text 2 label=Registration number 
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# Optional text 3 label= 

# Optional check box 1 label= 

# Optional check box 2 label= 

# Optional date 1 label=Date manufactured 

# Optional date 2 label= 

 

#e.g.  psychologist 

Optional text 1 label=Case manager 

Optional text 2 label=K10 pre treatment 

Optional text 3 label=K10 post treatment 

Optional check box 1 label=Paperwork done 

Optional check box 2 label= 

Optional date 1 label= 

Optional date 2 label= 

 

13.3 Titles List 

We have already looked briefly at changing the titles list. To do so select the Config->Edit 

titles menu item. 
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The title list is used when inputting names i.e. it loads the titles pulldowns / combo 

boxes. The default title is in the top of the list. 

 

You usually add titles as required. For example, if Princess Diana walks through your 

door you would add “Princess” to the list. If most of your clients are Princesses you would 

put the entry at the top of the file. 

13.4 Resources 

You can tick the resources that have been used for your client e.g. this could be used for 

psychology tests that you have given to a client.  
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Use the Config->Edit tests list menu item to maintain the list of the resources that you 

use. 

 

13.5 Check List 
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CleverClients enables you to set up a check list to remind yourself of the common steps you 

go through with client treatments. 

 

Use the Config->Edit check list menu item to set up your own check list. 

 

13.6 Marital Status 

Use the Config-> Edit marital status list to change the marital status pulldown list. 
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13.7 Service Numbers 

Use the Config->Edit service number list menu item to maintain the pulldown from which 

you can select service numbers. 

  

Use the Config->Edit services list menu item to maintain the pulldown from which you can 

select the types of services that you offer (reports, courses etc). 

You can also set the fee for all service numbers in the main configuration file. The 

service number list has the service code as the first word e.g. 

80005 MEDICARE Clinical Psych - out of rooms - (30-50 min) 

80100 MEDICARE FPS Service - in rooms - (20-50 min) 

80105 MEDICARE FPS Service - out of rooms - (20-50 min) 

You can set the fees in the main configuration with entries like: 

# Service code fee lookups 
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80010=119.80 

80015=140.15 

80000=81.60 

80005=102.00 

80100=57.80 

80105=78.65 

80110=81.60 

80115=102.50 

N0124=250.00 

 

  

13.8 Client types 

You can define your types of clients. You will probably use some of the supplied 

types and add some of your own. Generally if you several clients of a particular type and in 

particular if you have a special charge for that type of client, you should set up a client type in 

the list. 

For example, if your office is close to a university and a lot of your clients are 

students, and perhaps you offer a discount for them, then you should set up a “Student” type. 
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The first step is to select “Edit client type list” from the Config menu and add Student 

to it. 

 

The second step is to select “Edit configuration” from the Config menu and set up 

some entries for the new Student type. You will find it easiest to “clone” entries for existing 

types. A student type is similar to the Private type, which has entries like: 

 

Private_FEE=110 

Private_TAX=0 

Private_SESSIONS=0 

Private_CLAIM=0 

Private_CHECK= 

So you set up entries like the following, where your fee is say $60. 

 

Student_FEE=60 

Student_TAX=0 

Student_SESSIONS=0 

Student_CLAIM=0 

Student_CHECK= 
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It is probably obvious that  the name has to be exactly the same (here Student) in both 

configuration files. 

The entries mean the following: 

▪ Student_FEE=60 – what you charge 

▪ Student_TAX=0 – tax to be paid. You can decide whether it is added to the 

charge or included, but be consistent. 

▪ Student_SESSIONS=0 – the number of sessions for the referral. Used for 

government schemes or Insurance allocations, but not relevant here. 

▪ Student_CLAIM=0 – the system will remind you to claim after this number of 

days (irrelevant) 

▪ Student_CHECK= - gives a list of client and appointment compulsary fields. 

None here. Described below. 

For a more involved example, here are the entries for the BOMiHI scheme: 

▪ BOiMHI_FEE=110 

▪ BOiMHI_TAX=0 

▪ BOiMHI_SESSIONS=12 – each referral is for 12 sessions 

▪ BOiMHI_CLAIM=30 – We usually claim every two weeks, but will be 

reminded after a month. 

▪ BOiMHI_CHECK=RefNo,Referrer,DOB,K10,ExtDB – A reference number is 

required, the referring doctor must be specified, date of birth is required, the 

doctor must supply a K10 test result and data has to be entered into the 

BOMiHI web site. When you create a new BOMiHI client you will have 

several yellow fields until you supply the data. 

 

The checking flags are given as a comma separated list, and are: 
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▪ DOB – you should supply the date of birth 

▪ ExtDB – you should enter data into another organisations database on their 

web site 

▪ Group – the types has group appointments so the flag will be set by default 

▪ K10 – the doctor should supply the results of a K10 test 

▪ Referrer – you need to supply a doctor or Insurance company contact. 

▪ RefNo – a reference number is expected. 

▪ Service – you should enter a service number. 

You should edit the client list and remove or rename the types. Then you should edit 

the main configuration and set the fees you charge and create any new types. We suggest that 

you leave entries for types that you don’t use as you may want them as models later. 

13.9 Configuring Word Processors and Spreadsheets 

Your word processor and spreadsheet are started by CleverClients by using the 

configuration files WordProcessor.txt and SpreadSheet.txt respectively. If you can display 

letters then you will not have to do any configuration. 

These files need to contain the names of the executable files. For example if you run 

the file C:\Program Files\Microsoft Office\Office11\winword.exe on our system, Word will 

appear The actual file name depends on the version of office (or other software) that you 

have. 
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The supplied configuration as supplied will execute some versions of word that we 

know about. It will not work if: 

▪ You have some other version of word. 

▪ You installed into a non-standard place. 

▪ You are using other software. 

If Word does not start up you need to find out where it is installed. Use the Start-

>Search facility and look for the file name WINWORD.EXE. The select the “Config->Edit 

word processor run” menu item and set up a file. All you need is a single line similar to that 

displayed. Note the quotes, which are required because of the blanks in the file names. 

 

 

 

Similarly, if your spreadsheet does not appear you need to search for the file 

EXCEL.EXE and edit the configuration file using the “Config->Edit Sreadsheet run” menu 

item. 
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If you are using OpenOffice you need to search for swriter.exe and scalc.exe and edit 

the files as above. You will need files that look something like: 

"C:\Program Files\OpenOffice.org 2.4\program\swriter.exe" for the word processor, 

and 

"C:\Program Files\OpenOffice.org 2.4\program\scalc.exe" for the spreadsheet. 
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14.0  LETTERS 

Letters are defined as Rich Test Format (RTF) files in the Templates directory. 

 

TemplatesDir.png 

 

Letter templates are set up with known strings that are replaced with actual values 

from the current client and appointment. 

This does not work with the Word binary formats such as doc. We use the RTF 

format which is a plain txt file (you can read it in WordPad) although you could use other 

formats. 

RTF files with embedded images (e.g. your logo) can be large. 

14.1 Example 
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To repeat an earlier example; the following letter was generated by selecting Daisy 

Duck’s first appointment and the selecting “Referrer acknowledgement” from the Office 

menu. 

 

 

This was generated from the following template file: 
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As you can see, the template has some obvious values such as 

APPOINTMENT_DATE and CLIENT_FULL_NAME. 

Letters are automatically generated in the client’s directory and you will often modify 

them and save then before sending them off. 

14.2 Configuration 

The main configuration file contains some information about the business 

You should set up the values: 

Business Name = The Funny Farm Ltd 

Business Mail = crazy@gmail.xyz 
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Business Phone = 0598765432 

Business Fax = 12344321 

Business Address = 123 Main Street, Hicksville, New York. 

Business contact Full Name = Dr Crazy Horse 

Business reference number = ABN07654321 

14.3 Supplied Letters 

You will likely want to use some of the supplied letters, so the first thing would be to 

load them into your word processor and insert your usual letter header and signature blocks. 

There is also a “one off” menu item. If you want to create a non-standard letter you can edit 

the OneOffLetter.rtf template and select the menu item to generate the letter. 

14.4 Your Letters 

To generate your own letters start with one of the supplied templates, modify it and 

save it as a new RTF file in the templates directory. 

We have had problems doing this with word. You may have to set up a basic RTF file 

with your header that works and copy and paste to it to set up all the files. 

There is an example template which contains all the available strings (we use it for 

development and testing). You can display it as a letter in the usual way. Here is some of it. 
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. 

You can copy-and-paste from the Example.rtf file into your document. We 

recommend this as you need to have the spelling and case exactly right. Sometimes word 

doesn’t handle this. 

 

When you have defined you new letter you have to tell CleverClients about it and 

insert it into the Office menu. You do this by editing the main configuration file. For 

example, here are some lines from the file: 

Word extension=.rtf 

Invoice / receipt=templates\InvoiceReceipt.rtf, Anonymous 

Client notes=templates\Notes.rtf, OneOnly 

Referrer acknowledgement=templates\ReferAck.rtf, DateReqd 

Mid referral=templates\MidReferral.rtf, DateReqd 

End referral=templates\EndReferral.rtf, DateReqd 

Example=templates\Example.rtf 
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The first line “Word extension=.rtf” tells the system that we are using RTF files. If, 

for example, you were using OpenOffice, you might decide to use another type of file. 

The other lines define the Office menu items: 

▪ The part before the = is the menu item. 

▪ The next part is the file name (starting with templates) 

There may be comma separated flags following: 

▪ OneOnly means that there is only one file created for the letter for that client, 

and each time the file will be re-opened. 

▪ DateReqd means that the file name will contain todays date so you know from 

the directory when you wrote it. 

▪ Anonymous means that the output file is not stored for the user (its written 

into the tmp folder). 

The OneOnly flag is used with the Notes letter type which is a place for you to store 

whatever you want to write about the client. 

 

14.5 Rich Text Problems 

Sometimes you will find that whatever you do you cannot get a known text string to 

be replaced. This is because the actual RTF file does not have the complete text string. 

You can fix the template by opening it in NotePad. 

For example the following was in a template that would not display the client Email 

address: 

 

\par \tab \hich\af2\dbch\af31505\loch\f2     
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 Email: CLIENT_EM\hich\af2\dbch\af31505\loch\f2 AIL 

 

The template had to have the rubbish removed so the correct string is there i.e. 

Email: CLIENT_EMAIL 
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15.0  SMS AND MAIL 

15.1 Introduction 

CleverClients can send mail, and can send SMS messages by mailing them to a provider. So 

you need to configure both mail and SMS. 

15.2 Configuring mail. 

To enable mail you need to edit the configuration file so you have lines like the 

following: 

▪ Mail user=cleverclients@bigpond.com  - you Email address i.e. your account 

▪ Mail password=crazy – your account password 

▪ Mail host=mail.bigpond.com – your mail provider’s server 

▪ Mail port=25 

Most of the parameters are the same as you have put into outlook to define your Email 

account. 

You can also use a Gmail account by using lines like: 

• Mail user=cleverclients@gmail.com 

• Mail password=HaHa%^& 

• Mail host=smtp.gmail.com 

• Mail port=465 

mailto:user=cleverpsych@bigpond.com
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You have to ensure the POP is enabled in your Gmail account 

• Log into your Gmail account 

• Go to the Gmail settings 

• Choose Forwarding and POP / IMAP 

• Chooses enable POP (if is not set already) 

 

Check that you have configured mail correctly by using a mail option from the Mail 

& SMS menu. 

15.3 SMS Providers 

You can send SMS messages from CleverClients. 

Several companies can be found on the net and you can open an account with one of them. 

To send an SMS message you send an Email to the provider. For example to SMS a 

client with mobile phone number 04123456 you simply Email the message to 

04123456@provider.com where provider.com is the providers Email address. 

mailto:04123456@provider.com
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Messages cost 5 to 25 cents. 

You need a provider that works in the above way. Two are described below: 

You open an account using the Email address that you have configured. 

We have used Direct SMS (www.directsms.com.au). We have no relationship with 

them, but they have been helpful and it all works well. We set up an account with them and 

keep a positive credit with them. You can ask to be reminded when you credit gets low. We 

have set up the account so that if a client wants to reply it comes back to our mobile, but you 

can have it return via Email. They will give you a few free credits to try it out. 

To enable this facility you need to edit the configuration file so you have lines like the 

following (there is no password): 

▪ SMS host=directsms.com.au – the SMS provider Email 

▪ SMS password= 

 

The 5CentSMS provider (www.5centsms.com.au) is very cheap.  

After you have opened an account you can log into your account and go to the 

features page. Your password is given near the bottom of the page, and has to be sent 

as the subject of the Email along with your mobile number. The configuration file 

needs two lines like: 

▪ SMS host=sms.5centsms.com.au 

▪ SMS password=123456  0418765432 

Check that you have configured SMS correctly by using an SMS option from 

the Mail & SMS menu. 

15.4 Reminders 

http://www.directsms.com.au/
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Often clients do not show up for their appointments, so you can send them a reminder, 

usually the night before. For problem clients, you can send a second reminder an hour or so 

before the appointment. 

Reminders are automatically send in the evening or in the morning. When they are 

sent is defined in the main configuration file, and can be disabled there if not required. 

Use the “Mail & SMS -> Remind” menu items to manually send reminders. 

The system will remind the client via SMS if they have a mobile phone number, and 

fall back to any entered Email address if they don’t. 

You only need to have the occasional client turn up when they would have forgotten 

to pay for it. 

The text of the message is defined in the templates\Reminder.txt file: 

Your next appointment with Fred is on APPOINTMENT_DAY 

APPOINTMENT_DATE at APPOINTMENT_TIME.  

 

Please reply if you cannot attend or call Fred on 04 123 456. 

It would be a good idea for you to edit this file before use. 

We also have some clients who regularly respond to the reminder but still do not turn 

up. Sometimes this can be solved by making sure they have appointments later in the day. 

You can also set a flag against the client so they are sent an extra reminder just before the 

appointment. The number of hours before is a configuration item: 

# Send extra emails to clients who often do not attend 

# This is number of hours before their appointment 

Extra reminder hours=1 

You can also send an extra reminder from the SMS menu. 
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There is also a template file C:\CleverClientsData\templates\ReminderExtra.txt that 

you should edit. 

 

15.5 Missed appointments 

You can send a message to a client who did not turn up by selecting the missed 

appointment and using the “Mail & SMS -> Missed appointment” menu item. 

The text of the message is in the MissedAppointment.txt template file. 

 

15.6 Sending SMS 

You can send a message to a selected client or to all clients (after filtering). 

For us older people who have trouble using their thumb to input messages there is 

also a menu option that enables you to type in a message (max 160 characters) and send it. 

This pops up a dialog for you to use: 
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SMSdialog.png 

You can also set up a list of recipients to appear in the dialog by using the “Config-

>Edit SMS list” menu item. Follow the format below. 

 

ConfigSMS.png 

 

15.7 Sending Mail 

You can send mail by using similar menu items to those above for SMS. 

ConfigMail.png 

 

15.8 Work Lists 

You can have a list of client appointments and services sent to the defined staff in 

each diary the night before or in the morning (so you know if you have to get out of bed). 
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The list can be sent automatically by mail and / or SMS. You can also send it from the 

Mail & SMS menu. 

Automatic sending (if you are connected permanently to the internet) is defined in the 

main configuration file: 

# Sending list of today's appointments and services 

# nothing is sent if there are no appointments or services 

# hour is the morning if in range 6 to 10 

# or the evening before if 1700 to 2200 

Appointments list time=0 

# will send to this Email if given 

Appointments mail=crazy@gmail.xxx 

# will send SMS (short list) if mobile is given 

Appointments mobile=041234567 

 

15.9 Mail Problems 

If mail is not being sent check the black background screen for errors. The likely 

problem is that you are not connecting to the mail server. Obvious errors are in the 

configuration where you do not have the correct mail server, Email address or password. 

Failure to connect can also be caused by a Firewall or Anti-virus setting. For example, 

if you use Norton Internet Security you may have to go into Network settings -> Configure 

and turn off “Scan outgoing Email messages”. 
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16.0  DISASTERS 

16.1 Command Window 

As previously described, the command window will print out error messages if there 

are problems with your system. Hopefully they may make sense to you. You can mail the 

contents to us, and we will interpret them for you. 

16.2 New Computers 

If you have bought a new computer you should download the latest version of Java 

(from Oracle). 

Make sure that the time zone is set correctly (click on the time). 

New Word Processor 

If you have bought a new version of Microsoft Office (or other) and selecting an item 

from the Office menu does not display a letter you need to update your 

CleverClientsData\config\WordProcessor.txt file to give the executeable file. Look first at the 

latest CleverDemo\config\WordProcessor.txt file. 

16.3 Memory 
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If you are handling a larger number of clients you may exceed the maximum allocated 

memory. There will be a message in the command window of the form: 

java.lang.OutOfMemoryError: Java heap space 

The memory can be increased with the Xmx parameter on the run command in the 

C:\Program Files (x86)\CleverClients\RunCleverClients.cmd There is a maximum value that 

you can set, usually about 1500m. 

16.4 Database Recovery 

It is possible that some windows problem could result in a corrupted database with the 

resulting loss of client data. We have seen this happen when a fan failed in summer and the 

computer overheated, and when the windows system strangely “hung”. 

This should not be too serious as you have been regularly backing up your system, 

haven’t you? 

To restore a database you need to replace the existing Database.xml file in the 

database directory with a backup copy, restart CleverClients, and then manually re-enter 

recent appointments from your paper diary. There are usually many backup copies on the 

database in the CleverClientsData\backup folder – use the one with yesterdays date. 

The database file CleverClientsDatabase.xml will probably appear in windows 

explorer as a file called Database of type XML. 

 

DatabaseFile.png 



 79 

If you think that there is a problem with your disk, don’t delete the old database file 

but rename it which may stop the bad part of the disk being reused, and talk to your computer 

service person. 

Every time you start CleverClients a backup of your database is stored in the backups 

directory (and typically kept for a month). You can usually find a backup that is more recent 

than the one you made yourself. 

 

DatabaseBackups.png 

In summary: 

• Click on the latest database backup and copy it. 

• Go to the database folder and paste 

• Rename the existing database file e.g. to BADCleverClientsDatabase.xml 

• Rename the backup file to CleverClientsDatabase.xml 

 

A trap is that the latest backup may have been made of a corrupted database so is also 

corrupted – you will have to use an older backup. 
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16.5 Java Problems 

We have seen a case where some Java files were strangely deleted. If you see 

messages that seem to relate to Java or “classes” you may need to re-install Java.  

See www.java.com 
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APPENDIX A 

DATE FORMATS 

Date formats are those for the Java SimpleDateFormat class. This is an 

extract from the Java documentation. 

 

 

For more information search the net. 

16.5.1.1 DATE AND TIME PATTERNS 

Date and time formats are specified by date and time pattern strings. Within date and time 

pattern strings, unquoted letters from 'A' to 'Z' and from 'a' to 'z' are interpreted as 

pattern letters representing the components of a date or time string. Text can be quoted using 

single quotes (') to avoid interpretation. "''" represents a single quote. All other characters 

are not interpreted; they're simply copied into the output string during formatting or matched 

against the input string during parsing.  

The following pattern letters are defined (all other characters from 'A' to 'Z' and from 'a' 

to 'z' are reserved):  

L

etter  

Date or Time 

Component  

Presentati

on  

Examples  

G

  
Era designator  Text  AD  

y

  
Year  Year  1996; 96  

file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23year%23year
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M

  
Month in year  Month  July; Jul; 07  

w

  
Week in year  Number  27  

W

  
Week in month  Number  2  

D

  
Day in year  Number  189  

d

  
Day in month  Number  10  

F

  

Day of week in 

month  

Number  2  

E

  
Day in week  Text  Tuesday; Tue  

a

  
Am/pm marker  Text  PM  

H

  

Hour in day (0-

23)  

Number  0  

k

  

Hour in day (1-

24)  

Number  24  

K

  

Hour in am/pm 

(0-11)  

Number  0  

h

  

Hour in am/pm 

(1-12)  

Number  12  

m Minute in hour  Number  30  

file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23month%23month
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
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s

  
Second in minute  Number  55  

S

  
Millisecond  Number  978  

z

  
Time zone  

General 

time zone  

Pacific Standard Time; PST; 

GMT-08:00  

Z

  
Time zone  

RFC 822 

time zone  

-0800  

Pattern letters are usually repeated, as their number determines the exact presentation:  

• Text: For formatting, if the number of pattern letters is 4 or more, the full form is 

used; otherwise a short or abbreviated form is used if available. For parsing, both 

forms are accepted, independent of the number of pattern letters.  

• Number: For formatting, the number of pattern letters is the minimum number of 

digits, and shorter numbers are zero-padded to this amount. For parsing, the number 

of pattern letters is ignored unless it's needed to separate two adjacent fields.  

• Year: If the formatter's Calendar is the Gregorian calendar, the following rules are 

applied. 

o For formatting, if the number of pattern letters is 2, the year is truncated to 2 

digits; otherwise it is interpreted as a number.  

o For parsing, if the number of pattern letters is more than 2, the year is 

interpreted literally, regardless of the number of digits. So using the pattern 

"MM/dd/yyyy", "01/11/12" parses to Jan 11, 12 A.D.  

o For parsing with the abbreviated year pattern ("y" or "yy"), 

SimpleDateFormat must interpret the abbreviated year relative to some 

century. It does this by adjusting dates to be within 80 years before and 20 

years after the time the SimpleDateFormat instance is created. For example, 

using a pattern of "MM/dd/yy" and a SimpleDateFormat instance created on 

Jan 1, 1997, the string "01/11/12" would be interpreted as Jan 11, 2012 while 

the string "05/04/64" would be interpreted as May 4, 1964. During parsing, 

only strings consisting of exactly two digits, as defined by 

Character.isDigit(char), will be parsed into the default century. Any 

other numeric string, such as a one digit string, a three or more digit string, or 

a two digit string that isn't all digits (for example, "-1"), is interpreted literally. 

So "01/02/3" or "01/02/003" are parsed, using the same pattern, as Jan 2, 3 

AD. Likewise, "01/02/-3" is parsed as Jan 2, 4 BC.  

file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/DateFormat.html%23getCalendar()
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/lang/Character.html%23isDigit(char)
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Otherwise, calendar system specific forms are applied. For both formatting and 

parsing, if the number of pattern letters is 4 or more, a calendar specific long form is 

used. Otherwise, a calendar specific short or abbreviated form is used.  

• Month: If the number of pattern letters is 3 or more, the month is interpreted as text; 

otherwise, it is interpreted as a number.  

• General time zone: Time zones are interpreted as text if they have names. For time 

zones representing a GMT offset value, the following syntax is used:  
•      GMTOffsetTimeZone: 

•              GMT Sign Hours : Minutes 

•      Sign: one of 

•              + - 

•      Hours: 

•              Digit 

•              Digit Digit 

•      Minutes: 

•              Digit Digit 

•      Digit: one of 

             0 1 2 3 4 5 6 7 8 9 

Hours must be between 0 and 23, and Minutes must be between 00 and 59. 

The format is locale independent and digits must be taken from the Basic Latin block 

of the Unicode standard.  

For parsing, RFC 822 time zones are also accepted.  

• RFC 822 time zone: For formatting, the RFC 822 4-digit time zone format is used:  
•      RFC822TimeZone: 

•              Sign TwoDigitHours Minutes 

•      TwoDigitHours: 

             Digit Digit 

TwoDigitHours must be between 00 and 23. Other definitions are as for 

general time zones.  

For parsing, general time zones are also accepted.  

SimpleDateFormat also supports localized date and time pattern strings. In these 

strings, the pattern letters described above may be replaced with other, locale dependent, 

file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/util/Calendar.html%23LONG
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/util/Calendar.html%23SHORT
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverClientsWorkspace_3_1/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
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pattern letters. SimpleDateFormat does not deal with the localization of text other than the 

pattern letters; that's up to the client of the class.  

16.5.1.2 EXAMPLES 

The following examples show how date and time patterns are interpreted in the U.S. 

locale. The given date and time are 2001-07-04 12:08:56 local time in the U.S. Pacific Time 

time zone.  

Date and Time Pattern  Result  

"yyyy.MM.dd G 'at' 

HH:mm:ss z"  
2001.07.04 AD at 12:08:56 PDT  

"EEE, MMM d, ''yy"  Wed, Jul 4, '01  

"h:mm a"  12:08 PM  

"hh 'o''clock' a, zzzz"  
12 o'clock PM, Pacific 

Daylight Time  

"K:mm a, z"  0:08 PM, PDT  

"yyyyy.MMMMM.dd GGG 

hh:mm aaa"  
02001.July.04 AD 12:08 PM  

"EEE, d MMM yyyy 

HH:mm:ss Z"  
Wed, 4 Jul 2001 12:08:56 -0700  

"yyMMddHHmmssZ"  010704120856-0700  

"yyyy-MM-

dd'T'HH:mm:ss.SSSZ"  
2001-07-04T12:08:56.235-0700  

 

 


